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for Macintosh
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•	ImageBrowser
•	PhotoStitch
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New Features in This Version

Click a tab to jump 
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About this Manual

Notation Conventions

The contents of this manual are classified according to the following symbols. 

 IMPORTANT
•	The “Important” sections contain operating precautions or important topics. 

Ensure that you read them. 

 HINT
•	 The “Hint” sections contain procedural suggestions and tips for your convenience. Read them as 
necessary. 

Operating Environment

•	This manual uses Mac OS X v10.4 screen shots and procedures in the explanations. 
The screen shots and procedures may appear slightly different if you are using 
another version of Mac OS.

• The displayed screens and procedures may also differ slightly from the examples 
depending upon the camera or printer model in use.

•	The explanations in this guide are based on the premise that a Canon compact 
camera will be used with the software. 

Word Searches

This document is provided as an Adobe Reader document. Use Adobe Reader’s Search 
functions to find specific words or phrases that you recall but cannot find. To access 
this function, in Adobe Reader click the [Edit] menu and select the [Search] option. 

If you are using Adobe Reader 8 or later, you can also perform searches with the [Find] 
function right on the toolbar. 

Input search text here



Basic Functions  
& Features

Contents Things to  
Remember

Mastering  
the Basics

More Advanced 
Techniques

Appendices

3

This page and the next present the basic functions of ImageBrowser as well as some of 
its special features.

To Download

Downloading 
(p. 10)

Download images 
with a single click.
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To Print

Printing 
(p. 13)

Print with the layouts you want. 

To View

Magnifying 
the Display 
(p. 21)

Displaying 
Shooting 
Information 
(p. 21)

Comparing 
Images  
(p. 41)

Slideshows 
(p. 34)

To Organize

Changing 
File Names in 
Batches  
(p. 35)

Using Star Ratings  
(p. 37)

Deleting  
(p. 19)

Using Comments  
(p. 37)

Performing 
Searches  
(p. 39)

Next
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RAW

To Edit

Adjusting 
Color and 
Brightness 
(p. 22)

Red-Eye 
Correction 
(p. 23)

Inserting 
Text  
(p. 23)

Trimming 
(p. 22)

Converting 
RAW Images 
(p. 29)

Merging Images 
into Panoramas 
(p. 28) 

Formatting 
Images as 
Wallpaper  
(p. 31) 

Extracting Still 
Images from 
Movies  
(p. 32) 

Resizing 
Images  
(p. 30) 

Editing Movies 
(p. 28)

To Connect to a Camera 

Uploading 
to a Camera  
(p. 46) 

Configuring My 
Camera Settings  
(p. 44)

You can change the 
camera’s start-up image 
and shutter sound.

Controlling Shooting 
from the Computer  
(p. 42)

To Send Email

Attaching 
Images to Email  
(p. 33)

You can reduce 
image file sizes. 

Previous

TEXT

ABC
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The Two ImageBrowser Windows

Download Window/Organizing Window

The following two windows are the main ones used for ImageBrowser procedures. 

Download window, which opens when a camera is connected.
CameraWindow 
View of camera images

You can download all or a selection of images from the connected camera. 

CameraWindow closes and the 
screen changes after the images are 
downloaded from the camera. 

Organizing window for downloaded images.
Main Window 

Click this icon 
in the Dock. 

You can view, edit and print the images in the computer. 

Double-click 
an image.

The Viewer Window that appears 
when you view an image.
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Browser Window

How to Display the Browser Window

The Browser Window will display after camera images are 
downloaded and CameraWindow closes. You can also display it by 
clicking the ImageBrowser icon in the Dock (the bar at the bottom of 
the desktop).

•	If the ImageBrowser icon is not displayed in the Dock, double-click 
the Applications] folder, followed by the [Canon Utilities] folder, 
[ImageBrowser] folder and the [ImageBrowser] icon. 

Names of the Browser Window Parts

Menu Bar Display Modes

Last Acquired Images
Displays the last images 
downloaded.

Folder Area
Selects a folder to display.

Browser Area 
Icons that indicate image properties 
display around thumbnail images, as 
shown on the bottom left. 

Control Panel Display Control PanelProperties Icon (Displays image properties)

	 : Image recorded using the camera’s Stitch Assist mode

	: RAW image

	 : Movie

	 : Image with sound memo attached

	 : Protected image

	 : Image recorded using the camera’s AEB function

	 : Rotated image (rotated in display only)
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How to Perform Tasks

Selecting and Using Functions

You can use many ImageBrowser functions by selecting them from the Control Panel 
or a menu and then following the instructions in the window that opens. 

	1 Select a function from the Control Panel or a menu.

	2 Follow the instructions 
to perform the task.
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Downloading Images

Downloading Images by Connecting the Camera to a Computer

Download the camera images to the computer.

 IMPORTANT
•	The instructions in this software manual assume that you have correctly installed 

the software. See the guides supplied with your product package for software 
installation procedures.

•	If CameraWindow fails to open when you connect the camera, click the 
[CameraWindow] icon in the Dock (the bar at the bottom of the desktop).

	1 Connect the camera to the computer 
with the supplied interface cable. 

	2 Set the camera to the Playback mode 
and switch on the power. 

	3 Click [Transfer Untransferred 
Images Automatically]. 
The images will start to 
download.

CameraWindow 
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When you click [OK] in the dialog that indicates the transfer is complete, the 
downloaded images will display in the Main Window.

You can select the newly downloaded 
images by their shooting dates or My 
Category (select models only) classification. 
(These are virtual folders.)

 : Folders containing 
newly acquired images

•	 Images from memory cards with large numbers of images (more than 1,000) may not download 
correctly. If this happens, please use a memory card reader to download. 

 HINT
Changing the Download Destination Folder 
The default settings save downloaded images into the [Pictures] folder. 
To change the destination folder, select [Operate using this computer] 
in CameraWindow, then click the button shown on the right, and 
select a folder. 
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 HINT
Selecting Images to Download
To download only a selection of images from the camera, select [Operate using this computer] in 
CameraWindow that first appears and then perform the following procedures. 

1   Select images to download.

2   Start the download. 

Downloading Using Camera Commands 
You can use the camera’s  (Print/Share) button to download the images to the computer (Direct 
Transfer). See the Camera User Guide for Direct Transfer settings and procedures. 

Downloading from a Memory Card Reader
ImageBrowser will start when you insert a memory card into the memory card reader, and display the 
following window. Use this window to perform the downloading procedures. 

Downloads all images that have not yet been 
downloaded.

Allows you to select and download images. 

Prints images.

Configures the download folder 
and other settings.
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	2 Click [Print & Email], and 
[Photo Print].

	1 Select images for printing.

Printing

Printing a Single Image on a Single Page

Prints one image per page. 
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	3 Set the categories as desired. 

Sets the printer, paper 
size and borderless 
printing settings.

Click here to 
crop and print 
a portion of an 
image.

Click here to insert 
text onto an image 
and print. 

Sets the shooting 
date/time imprint 
settings.

	4 Click [Print].
Print window will display. 

	5 Click [Print].
Printing will start. 

 HINT
Laying Out and Printing
You can also select multiple images, add captions and print freely composed layouts on a single page. 
Click [Print & Email] in the Control Panel and select [Layout Print]. The shooting date will automatically 
appear when you perform a layout print if you click the [ImageBrowser] menu, followed by [Preferences] 
and [Layout Print], and place a check mark beside [Shooting Date].
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Index Print

Prints an index of the images. 

	1 Select images for printing.

	2 Click [Print & Email], and 
[Index Print].



Basic Functions  
& Features

Contents Things to  
Remember

Mastering  
the Basics

More Advanced 
Techniques

Appendices

16

	4 Click [Print].
Print window will display. 

	5 Click [Print].
Printing will start. 

	3 Set the categories as desired. 

Sets the printer, paper 
size and number of 
print copies settings.

Rotates selected 
images.

Click here to crop a portion of the 
selected image and print it. 

Select an image to rotate or trim. 

Sets the number of 
rows or columns.

Configures the printing of 
the shooting information, 
comments, headers, 
footers or page numbers. 
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How to Use CameraWindow

First Window to Open

This is the first screen to appear in CameraWindow.

Downloads all images that have 
not yet been downloaded.

Closes this window and opens a 
camera image browser window that 
lets you select and download images.  



Basic Functions  
& Features

Contents Things to  
Remember

Mastering  
the Basics

More Advanced 
Techniques

Appendices

18

Screen Showing the Image Index List and Image View

The Thumbnail Window on the left of the screen displays the images on the memory 
card in the camera as “thumbnails” or small versions of the images in an index list. 
When you select an image from the Thumbnail Window, the image displays in the 
View Window on the right.  

Thumbnail Window View Window

Aligns the windows.

Switches between 
window display modes.

Configures settings such as the 
thumbnail size and download folder. 

Configures the name 
of the camera owner.

Uploads computer 
images to the camera. 

Selects all images/images 
not yet downloaded.

Downloads images selected 
in the Thumbnail Window. 

These arrows switch the 
image in the View Window.

Closes 
CameraWindow. 

Prints images selected in 
the Thumbnail Window. 

 HINT
Use the Help Function
ImageBrowser is equipped with a convenient “Help” function. Use it when you are unsure how to 
proceed. To view it, click the [Help] menu and select [ImageBrowser Help].  
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How to Use the Browser Window

Browser Window

This is the main window for performing tasks in ImageBrowser.

Last Acquired Image/Folder Area
Selects a folder to display.
•	 You can register folders you use 
often as Favorite Folders ( ). 
Register by clicking [Add]. 

Browser Area
•	 Displays the images in 
the selected folder.

Image Information
Preview Mode: Displays information 
about the selected image.
Index List Mode: Displays image 
information if you click the [File] 
menu and select [Get Info].

Canon Camera
Displays CameraWindow.

View Image
Displays the selected image in 
the Viewer Window. 

Slide Show
Displays the selected images in 
succession in the window.

Rotate Image
•	 To rotate images, click the [Edit] menu and select [Rotate Image].
•	 To rotate the original image in the displayed direction, click the 
[Edit] menu and select [Rotate According to Rotation Information].

•	 Rotate movies by clicking the [Edit] menu and selecting [Movie Edit].

Display Control Panel
Configures the settings 
for displaying images in 
the Browser Area.

Send to Trash
Deletes selected images or folders 
•	 Deleted images are placed in the Trash.
•	 If you mistakenly send an image to the 
Trash, click the [Trash] icon in the Dock 
and restore the image to its original 
folder in the Finder.

Print & Email
Prints the selected image(s).
Or creates an image attachment for email.
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Browser Area Tasks

Display Mode
Selects a display mode for the Browser Area.

Preview Mode: allows the 
image information to be read 
while viewing the image.

List Mode: allows 
thumbnails to be viewed at a 
size suited for easy viewing.

 HINT
Right-Click Context Menus
Right-clicking (or [ctrl] key and clicking) over a window or image displays contextual menus. These menus 
contain the functions available in the current context as well as other convenient functions. Use the 
context menus to increase your efficiency.  

Change the Display Size
You can change the display 
ratio (Zoom mode) or 
thumbnail size (Scroll mode) 
with the slider.

Functions Used in the Browser Area
Create New Folder
To create a new folder in the Browser Area, click the 
[File] menu and select [New Folder].

Select Images 
Clicking an image in the Browser Area selects that 
image. To select multiple images, hold down the 
[shift] key or [ ] (Command) key while clicking 
images, or hold down the [option] and [shift] key 
together and click a starting and ending image to 
select a range of adjacent images.

Display Images

Double-clicking an image in the Browser Area (or 

selecting the image and clicking  ), displays it in 

the Viewer Window.

Move, Copy Images
To move an image between folders, drag it over the 
destination folder and release the mouse button. 
To copy an image, hold the [option] key while 
releasing the mouse button as above.

Show Window 
You can switch between 
showing/hiding the Folder 
Area, Control Panel and 
Information Panel. 
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Viewer (View Image) Window

Double-clicking an image in the Browser Window displays it in this window. 

Change the display 
magnification.
Zooming in displays 
the Navigator window 
to show the relative 
position on the image.

Saves an image.

Edit an image.

Display multiple 
images side by side.

Display the shooting information.
You can configure the 
information display by clicking 
the [ImageBrowser] menu and 
selecting [Preferences].

Display at full screen size.

Shooting information

Set the Star Rating.

•	The [Display Original Image] button will display beneath RAW images in the Viewer Window. Click this 
button to display the converted image  in the Viewer Window.

•	Buttons appear beneath movies selected in the Viewer Window, allowing you to replay the movie or adjust 
the sound volume. The [Save as Still Image] button will appear above the Star Rating section. Clicking this 
button extracts still images from the movie. 
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Editing Images

 IMPORTANT
•	The original image will be overwritten after an image is edited unless the file 

name is changed before saving it. To preserve the original image intact, change 
the file name when saving the edited image. 

•	This section introduces the procedures for starting from the [Edit] button in the Viewer Window, but you 
can also start the same process by clicking the [Edit] menu and selecting [Edit still image]. 

Trimming–Cropping a Portion of an Image

Use this to delete unnecessary portions of the image and leave only the necessary 
portions.

Procedures

1 Double-click an image.

2 	 [Edit] and [Trimming 
Image].

•	You can also input values or an aspect 
ratio to specify the trim area. 

•	Movies and RAW images cannot be 
edited. 

Color/Brightness Adjustment

Adjusts the images’ RGB values (red, green, blue) and the saturation and brightness. 

Procedures

1 Double-click an image.

2 	 [Edit] and [Color/
Brightness 
Adjustment].

Movies and RAW images cannot be edited. 

RGB Adjustment

Saturation, 
Brightness
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Red Eye Correction

Restores eye appearance to the original color when light reflected from the flash 
makes them appear red. 

Procedures

1 Double-click an image.

2 	 [Edit] and [Red Eye 
Correction].

Movies and RAW images cannot be edited. 

Inserting Text

Use this to insert text onto the image. 

Procedures

1 Double-click an image.

2 	 [Edit] and [Insert 
Text].

•	Placing a checkmark in the [Antialias] box 
causes the text edges to blend in with 
the underlying image. 

•	Movies and RAW images cannot be 
edited. 

•	Click [Start] when Auto Mode is selected.
•	Switch to Manual Mode if Auto Mode cannot correct the 
image and select the location of the eye to correct.  

HELLO

You can freely adjust the font, 
size, color and text attributes.
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Correcting Levels

You can adjust the highlights (brightest portions), shadows (darkest portions) and mid-
tone levels of an image while viewing its histogram. 

Correcting Tone Curves

You can adjust the color balance and brightness of an image using its tone curve 
(input/output conversion graph of image brightness).

Tone Curve Adjustment

Level Adjustment

Procedures

1 Double-click an image.

2 	 [Edit] and [Level 
Adjustment].

Movies and RAW images cannot be edited. 

Procedures

1 Double-click an image.

2 	 [Edit] and [Tone 
Curve Adjustment].

Movies and RAW images cannot be edited. 
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Sharpen

Adjusting Sharpness–Emphasizing Outlines

Makes images appear sharper by emphasizing the outlines of subjects, such as people 
and objects. 

Procedures

1 Double-click an image.

2 	 [Edit] and 
[Sharpness].

•	Movies and RAW images cannot be 
edited. 

Auto Adjustment

Automatically adjusts the image color balance and brightness. 

Procedures

1 Double-click an image.

2 	 [Edit] and [Auto 
Adjustment].

Movies and RAW images cannot be edited. 
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Using Other Editing Software

If you register another image editing program with ImageBrowser in advance, you can 
use that software to edit an image selected in ImageBrowser.

Registering an Editing Program

Register the program so 
it can be started from 
within ImageBrowser. 

Procedures

1  
[ImageBrowser] and 
[Preferences].

2 [Register Application]ImageBrowser Other Image 
Editing Program

Editing Images with a Registered Editing Program

Procedures

1 Double-click an image.

2 	 [Edit] and [Edit 
with Registered 
Application].

•	The shooting information may be lost 
from images recorded with the camera 
and then processed and saved with 
another image editing program.  

•	Movies and RAW images cannot be 
edited. 
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Attaching Sounds

You can add sound to images and play back the sounds.

Adding Sound

Procedures

1 Select an image.

2  
[File], [Sound] and [Record].

•	 ImageBrowser’s Sound Recorder uses 
the Mac OS X recording function. If 
required, prepare such equipment as a 
microphone, and check that recording 
is enabled in the [System Preferences], 
[Sound] window. 

•	To delete a recorded sound, click the 
[File] menu and select [Sound], followed 
by [Send to Trash].

•	To record a new sound for an image 
that already has one associated with it, 
click the [File] menu and select [Sound], 
followed by [Record].

 IMPORTANT
•	Sounds cannot be attached to movies.

Playing an Image Sound File

Procedures

1 Select an image.

2  
[File], [Sound] and [Play].

•	You can also play sounds in the Preview 
Mode and the File Information Window.

Symbol displayed on image 
thumbnails to which sound 
files have been added.



Basic Functions  
& Features

Contents Things to  
Remember

Mastering  
the Basics

More Advanced 
Techniques

Appendices

28

Creating Panoramic Images–PhotoStitch  

You can create wide panoramic images by moving the camera slightly when recording 
a series of images and merging them into one image.

 HINT
Using the Stitch Assist Mode 
If you use the camera’s Stitch Assist mode to record the images, PhotoStitch can automatically detect the 
image order and merge direction, making it easier to merge the images. (Some camera models may not 
feature the Stitch Assist mode.)

Editing Movies

You can create original movies by linking movie clips and still images. 
You can even add titles and other text, background music and various special effects 
to the movie.

Procedures

1 Select the images that you 
want to stitch together.

2  
[Edit] and [PhotoStitch].

•	Movies and RAW images cannot be 
edited. 

Use the PhotoStitch program 
to create panoramic images.

Procedures

1 Select an image (movie or 
still image).

2  
[Edit] and [Movie Edit].

•	You can configure the default settings 
for editing movies by clicking the 
[MovieEdit Task] menu and selecting 
[Preferences].

ABC
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Converting RAW Images

You can convert RAW images to JPEG and TIFF images.

Image type retaining 
the detailed image 
data from the initial 
capture.

Image type suited for pasting 
into word processing documents 
and general programs, and for 
sending email. 

Exposure correction

Color adjustment

Lossless 
image 

adjustments 
possible

White balance adjustment

Color space configuration

Procedures

1 Select a RAW image.

2  
[File] and [Processing RAW 
Image].

•	You can use the Image Quality 
Adjustment Window to adjust the image 
brightness and color to your satisfaction. 

 HINT
About RAW Images
RAW images contain the data captured by the camera’s image sensor without modification. Since they 
contain raw data that differs from the usual JPEG images by not having any image adjustment or compression 
processing performed in the camera, they can be converted on a computer with a lossless process. 

RAW JPEG, TIFF...

Processing in the Camera

Standard Image 
Capture

Image Adjustment

Compression JPEG Image

Image sensor 
data from 
shutter release

Image adjustment 
& compression 
automatically performed

RAW Image 
Capture RAW Image

Processing by Computer

•	 Can be used with general programs. 
•	 Image is subject to degradation when 
adjusted because it has been compressed.

JPEG Image,
TIFF Image

•	 You can view the image while making 
adjustments without worrying about quality loss. 

•	 Processing with ImageBrowser is required to 
view the images with general programs. 

Image Adjustment

Compression

ImageBrowser  
RAW Image Processing

 IMPORTANT
•	RAW images can only be captured on certain camera models that list “RAW” as one 
of the data types included in the “Specifications” section of the Camera User Guide. 
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Exporting

Changing Image (Stills) Sizes and Types

You can change an image’s size and format when exporting it so that it can be 
published on the Internet or attached to an email message. 

Procedures

1 Select an image.

2  
[File] and [Export Image].

3 [Edit and Save Image]

4 [Next >]

•	You will lose the shooting information 
if you save images as a type other than 
JPEG. 

.bmp .jpg .tif

Exporting Shooting Information

You can export the shooting information recorded with an image, such as the shutter 
speed and exposure, as a text file.  

Ascertain the causes of 
failed photos or compare the 
settings for several images.

Procedures

1 Select an image.

2  
[File] and [Export Image].

3 [Export Shooting Properties]

4 [Next >]
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Creating Computer Screen Saver Images

You can export images to serve as computer screen savers. 

Creating Computer Wallpaper Images

You can export images to serve as computer wallpaper images.

Procedures

1 Select an image.

2  
[File] and [Export Image].

3 [Export as a Screensaver]

4 [Next >]

Procedures

1 Select an image.

2  
[File] and [Export Image].

3 [Export an Image as 
Wallpaper]

4 [Next >]
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Extracting Stills from Movies

You can extract and save stills from your favourite frames recorded in a movie. 

Extract your best 
shots as stills

Procedures

1 Select an image.

2  
[Edit] and [Extract frames 
from a movie].
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Email

Attaching Images to Email

You can send images as email file attachments. 

You can configure 
the image size and 
quality settings.

Procedures

1 	[Print & Email] and 
[Create Image for 
Email].

•	You can configure how the email 
program automatically starts up after 
the image is created by opening the 
[Applications] folder, and double-clicking 
the [Mail] icon to start the Mail program, 
and clicking the [Mail] menu, followed by 
[Preferences] and the [General] tab. 

•	 Images in the [Email Images] folder can 
be found by opening the [Users] folder 
on the startup disk, followed by the [User 
Login Name], [Library], [Preferences], 
[ImageBrowserUserData] and [Mail] 
folder. 
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Slide Shows

Viewing Images in Slide Shows

A multiple selection of images can be shown at full size on the screen in succession as 
a slide show. 

You can freely configure the 
transition effects, information 
displayed and display time settings.

Procedures

1 	[SlideShow]

•	You can configure the slide show display 
method by clicking the [View] menu and 
selecting [Slide Show Options].

 HINT
Slide Show Button Functions
The following buttons appear at the bottom of the screen while a slide show is playing. 

You can set the Star 
Rating for an image 
while it is displayed. 

Rewind Pause Forward

After the slide show, 
the images you 
clicked during the 
show remain selected.

After the slide show, 
the images you clicked 
during the show appear 
in a printing window. 

Stops the slide show.

Go to first image Advance to last frame
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Image Management

Changing File Names in Batches 

You can change the file names of multiple images in one procedure.

Name + Number

Shooting Date + Number

Name + Shooting Date + Number

Shooting Date + Name + Number
 

Change randomly 
numbered images 
and received images 
into consecutively 
numbered images. 

xxx_01 xxx_02 xxx_03 xxx_04 xxx_05

Procedures

1 Select an image.

2  
[File], [Organize Image] and 
[Rename].

•	You can change individual file and 
folder names by clicking on the file 
name in Preview mode or with the File 
Information Window. 

•	Changing the image name in 
ImageBrowser also changes the actual 
file name on the disk. 

Sorting Images into Folders by Shooting Date

You can sort images into folders by their shooting dates.

Images predating your use 
of ImageBrowser can also 
be managed together. 

Procedures

1 Select an image.

2  
[File], [Organize Image] and 
[Sort Images].

3 [The files will be separated 
into folders for each 
shooting date.]

4 [Next >]

200x/05/15

200x/05/16

200x/05/17
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Classifying Images Into Star Ratings Folders

You can classify images according to their Star Ratings into separate folders. 

You can organize the images 
you have recorded according 
to their Star Ratings. 

Procedures

1 Select an image.

2  
[File], [Organize Image] and 
[Sort Images].

3 [The files will be organized 
by Star Rating.]

4 [Next >]
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Configuring Image Information Settings

Setting Star Ratings

You can set the Star Ratings used in searching and displaying images in the index list.

: Ultimate
: Moderate
: Okay

Procedures

1 Select  an image.

2  
Switch to [Preview Mode].

3 Set [Star Rating].

•	You can also set the Star Ratings by 
accessing the [Edit] menu, the File 
Information Window or the Viewer 
Window.

Inserting Comments

You can freely insert your choice of text as Comments.

Trip to the blue sea

Endless white
 

sandy beache
s

Relaxing 
afternoon 
snooze

Your choice of text 
as comments

Procedures

1 Select  an image.

2  
Switch to [Preview Mode].

3 Insert [Comment].

•	Comments can also be managed in the 
File Information Window. 
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Family, Animals

Family, Trips

Friends, Holidays

Assigning Keywords

You can set Keywords for use in image searches.  

Select keywords

Procedures

1 Select  an image.

2  
Switch to [Preview Mode].

3 Set [Keywords].

•	Keywords can also be managed from the 
[Edit] menu or File Information Window.

•	To add keywords, click the [Edit] menu 
and select [Manage] from the [Keyword] 
submenu.

 HINT
About the Image Information
This chart shows the information other than shooting information that can be added to images.

Information Type My Category Star Ratings Comments Keywords

Content
Categories such as 
People, Scenery, etc.

Rated on basis of 3 
rankings: , , 

Text input without 
restriction regarding 
the shooting 
circumstances 
or associated 
memories.

Selections are made 
from a list (editable) 
of keywords, such 
as the photographic 
subject, place or 
action. 

Configuration 
Method

Configured in 
Camera

Configured in ImageBrowser

Used in Searches — O O O

Used as Filter 
Criteria

O O — —

Display beneath 
Thumbnail

O O O —

Categories displayed beneath thumbnails can be selected from the [View] menu and [View Settings] 
submenu.
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Searching, Filtering and Sorting Images

Searching Images

You can search images using parameters extracted from the information associated 
with them.  

Comment

Date

Keyword

Favorite photo

Procedures

1  
[File] and [Search].

•	After a search, the correlated images 
display in the [Search Results] folder. 

 HINT
Tasks Related to Search Results
You can select images in the [Search Results] folder and perform operations on them, such as printing or 
copying them to other folders. 

 IMPORTANT
•	Please note that deleting an image from the [Search Results] folder deletes the 

original image. Use caution in deleting items from this folder. 
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Procedures

1  
[View] and [Sort].

Filtering Images

You can use filters to display only images meeting the selected parameters in the 
Browser Area.

Star Ratings My Category

Procedures

1   
[Filter Tool]

This section is used to specify the filter criteria.

Sorting Images

You can sort images in the Browser Area based on the specified parameters. 

File Name

Type

Shooting Date/Time

File Size

File Modification

Ascending/
Descending 

Order

A B C D E

A BCD E
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Comparing Images

Comparing Multiple Images

When a good photo opportunity arises, you can shoot the same subject using different 
shutter speeds and exposures. In ImageBrowser, it is easy to compare images so that 
minute differences can be detected.

Procedures

1 Select several images to 
compare.

2 	[View Image]

3  Select a view method 
from [Number of 
Displays].

4  [Synchronize]

•	Selecting [Synchronize] causes actions 
such as increasing/reducing the 
magnification level or scrolling around 
the image to apply to all of the selected 
images in lock step, making it easy to 
check minute details of focus, coloring 
and other image characteristics.  

Actions, such as scrolling or changing the magnification, are performed 
on both images no matter which image it is performed upon.  
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Remote Shooting

Operating the Camera Using Computer Commands

You can activate the shutter of a connected camera from the computer. 

Also useful for fixed position 
or unmanned recording. 

Procedures

1 Connect the camera to the 
computer.

2 Set the camera to the 
Playback mode and switch it 
on. 

3 If CameraWindow opens, 
click [Operate using this 
computer], followed by .

4 Open the [Applications] 
folder, [Canon Utilities] 
folder, [CameraWindow] 
folder, and double-click the 
[RemoteCapture DC] icon.

 IMPORTANT
•	Remote shooting is only available with certain camera models that list it as one 
of the features in the “Specifications” section of the Camera User Guide. 

•	Ensure that you turn off your computer’s Sleep feature before you begin remote 
shooting. The results cannot be guaranteed if the computer enters Sleep mode 
while remote shooting.

•	Except for the shutter button, the camera’s buttons and switches, including 
the zoom, cannot be manually operated while the camera is being remotely 
controlled.

•	The time lag between pushing the shutter button and the release of the shutter 
is slightly longer for remote shooting compared with the normal mode of 
operation.
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Remote Shooting Window

Selects the image’s recording 
size and compression.

You can add a comment 
to an image.

Viewfinder

Sets the shooting settings.

Sets the rotation setting of the 
image being recorded.
This setting cannot be adjusted 
if the [Auto Rotate] function of 
your camera is set to [On].

Releases the camera shutter (you 
can also release it by pressing 
the camera’s shutter button or 
the space bar on the keyboard).

Sets the camera’s zoom.

Turns the viewfinder 
display on or off.

Resets the exposure, focus 
and white balance settings.

 HINT
Interval Timer Shooting
This method captures a set number of frames recorded at set intervals of time. Click the [Shooting] menu 
and select [Interval Timer Shooting]. (Short intervals may be insufficient for image transmission and saving, 
resulting in the failure to capture images at the specified interval.)

Timer Shooting
This method captures a single image after a set number of seconds. Click the [Shooting] menu and select 
[Timer shooting]. The timer interval settings range from 2 seconds to 30 seconds.

Displaying Subjects on the Camera’s LCD Monitor
You can use the camera’s LCD monitor or a television connected to the camera to view the subject while 
shooting remotely. Click the [Camera] menu and select [Camera Display Settings]. See the Camera User 
Guide for TV connection instructions.

Shooting Without Worrying about Memory Card Capacity
Clicking the [RemoteCapture DC] menu and selecting [Preferences] opens the Preferences window. If you 
place a check mark beside [Computer only] in the [Save Images On] section, you can continue recording 
without worrying about free space on the camera’s memory card.  
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My Camera Settings

Changing the Shutter Sound and Start-Up Image

The camera’s start-up image, start-up sound, shutter sound, operation sound and self-
timer sound are collectively referred to as My Camera Settings. You can register your 
own custom images and sounds as the My Camera Settings.

My Camera Settings
•	 Start-up Image
•	 Start-up Sound
•	Operation Sound
•	 Selftimer Sound
•	 Shutter Sound

Procedures

1 Connect the camera to the 
computer.

2 Set the camera to the 
Playback mode and switch it 
on. 

3 If CameraWindow opens, 
click [Operate using this 
computer], followed by .

4 Open the [Applications] 
folder, [Canon Utilities] 
folder, [CameraWindow] 
folder, and double-click the 
[MyCamera DC] icon.

 IMPORTANT
•	My Camera Settings are only available with certain camera models that list them 
as features in the “Specifications” section of the Camera User Guide. 

•	Do not interrupt the connection between the camera and computer when My 
Camera Settings are being transmitted between them. 
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You can register the start-up 
image, start-up sound, shutter 
sound, operation sound and 
self-timer sound collectively if 
you select [Theme].

My Camera Settings 
registered in the camera.

My Camera Settings 
in the computer.

After selecting a My Camera Settings file from the left-hand list, 
select a My Camera Settings file to replace in the right-hand list 
and click this button, then click [Set to Camera]  to register it in 
the camera. 

 HINT
Creating My Camera Settings
Comply with the following specifications if you create My Camera Settings in image editing or sound 
editing software.   

Start-up images:	 Compression Method: JPEG (Baseline JPEG)
	 Data Sampling: 4:2:0 or 4:2:2
	 Pixels (w x h): 320 x 240 pixels

Sound files:	 Compression Method: WAVE (Monaural)
	 Quantifying Bits: 8 bit
	 Sampling Frequency: 11.025 kHz or 

8.000 kHz (Use the chart on the right 
as a guideline for the length of sound 
files recorded with the camera.)

Type Duration in Seconds

11.025 kHz 8.000 kHz

Start-Up Sound 1.0 sec. or less 1.3 sec. or less

Operating Sound 0.3 sec. or less 0.4 sec. or less

Self-Timer Sound 2.0 sec. or less 2.0 sec. or less

Shutter Sound 0.3 sec. or less 0.4 sec. or less
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Uploading Images

Uploading Images to a Camera

You can upload images from a computer to a memory card in a camera. 

Procedures

1 Connect the camera to the 
computer.

2 Set the camera to the Playback 
mode and switch it on. 

3 Click [Operate using this 
computer].

Show favorite images 
to friends or connect 
a TV to show them 
on a large screen.

 IMPORTANT
•	Only images compliant with Design rule for Camera File system standards can be 
uploaded to your camera’s memory card.

4 Click  (Send to Camera).

•	 If the Browser Window is open when 
the camera is connected (directly 
after downloading for instance), open 
CameraWindow by clicking the [Canon 
Camera] icon in the Control Panel of the 
Browser Window.
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Preference Settings

Customizing ImageBrowser

You can configure ImageBrowser to operate according to your preferences.

•	Overall coloring, such as 
window appearances

•	 Processing methods for 
images shot with the 
camera on end

•	 Categories of shooting 
information displayed

•	 Show/hide messages
•	 Print settings
•	 Registering applications

Procedures

1  
[ImageBrowser] and 
[Preferences].
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Supported Image Types
The following is a list of image types supported by ImageBrowser.

JPEG
Most cameras use this image type. It compresses at very high ratios, taking advantage 
of the characteristics of the human eye. However, because it is an irreversible 
compression method (part of the data is lost during compression), if you process and 
save an image repeatedly using this method, the image may become rougher.
Exif JPEG is an image type that adds information such as shooting data to a JPEG 
image.

RAW
This is a proprietary image type provided by Canon. It allows the output of the image 
pixels from a digital camera without any deterioration in the quality of the image. 
Some cameras might not support this image type.

PICT
This is the standard image type for Macintosh. This image type is supported by most 
Macintosh software.

TIFF
This is a relatively popular image type. It is widely supported by non-Macintosh 
programs (such as Windows).

Windows Bitmap
This image type comes standard with Windows. Most Windows programs support it.

QuickTime/AVI
These are movies, which display as a movie icon in the Browser Area of ImageBrowser.
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New Features in This Version
The following features were added or changed in this version of ImageBrowser. 
(ImageBrowser Ver. 5.8 to 6.0)

CameraWindow Makeover 
CameraWindow has been completely revamped to make the linkage tighter between 
Canon brand cameras and ImageBrowser and to add convenience and functionality. It 
may not be possible to use the new CameraWindow with some camera models.

Changes to Memory Card Downloading Methods 
The Camera Control Window was used in prior versions to download images from 
memory card readers. From this version onward, these downloads are performed as an 
ImageBrowser function in the Browser Window. The data reading speed has also been 
significantly accelerated.

Text Insertion Feature Added to Printing Functions
In addition to the ability to print such information as the shooting date with the 
image, you are now able to add text freely during the printing preparation. Greeting 
cards and photos bearing messages can now be made with ease. 

Task Button Revisions
The Control Panel Buttons composition has been revised to make the tasks more 
intuitive.

•	The starting point for the “Create Image for Email” process has shifted from the 
[Internet] button to the [Print & Email] button. 
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Software User Guide     Macintosh     (ImageBrowser, PhotoStitch)

Disclaimer
•	While every effort has been made to ensure that the information contained in this guide 
is accurate and complete, no liability can be accepted for any errors or omissions. Canon 
reserves the right to change the specifications of the hardware and software described 
herein at any time without prior notice.

• No part of this guide may be reproduced, transmitted, transcribed, stored in a retrieval 
system, or translated into any language in any form, by any means, without the prior written 
permission of Canon.

• Canon makes no warranties for damages resulting from corrupted or lost data due to a 
mistaken operation or malfunction of the camera, the software, memory cards, personal 
computers, peripheral devices, or use of non-Canon memory cards.

Trademark Acknowledgments
• Macintosh, the Mac logo, QuickTime and the QuickTime logo are trademarks of Apple, Inc., 
registered in the U.S. and other countries.

CDA-E014-010	 © 2007 CANON INC.
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